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CHAPTER 1

Introduction

Welcome

GraFit version 6 for Microsoft ~ ® Windows £ combines presentation -quality scientific
graphs with comprehensive data fitting. The result is a powerful package that is

easy to use, produces stunning output, and can also fulfill the needs for
guantitative data analysis. Data can be fitted using variou s types of theoretical
models, and your own equations can easily be added to those supplied with the
program. Comprehensive graph plotting facilities allow you to display your data on

screen and edit the graphs interactively.

Key Features of GraFit

GraFit provides the experimental scientist with a tool for visualization and analysis

of their data. For the occasional user, GraFit can be configured to perform routine
analyses with minimal intervention d in many cases it is possible just to enter the
data and al low GraFit to calculate the results and plot the graphs in the
background. Advanced users can utilize the full power of GraFit for analyzing
complex equations, and may create custom fitting templates for routine data
processing.

13
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About this Guide

This manu al describes how you can use GraFit to examine your data, and to plot
graphs. We recommend that you read the manual fully, and try out some of the
examples described.

Notational Conventions

The following notational conventions are used throughout this manu al:
Convention Meaning
SMALL CAPITALS Small capitals indicate keys to be pressed. For instance,
A
indicates fipress the O6A0 keyo. I f more

pressed this is written as (for instance)
SHIFT END

which woul d mean Aholdd kdeown ntdh & héSh ipfrte s
O0Endd keyo.

Monospace Monospace type indicates text that should be entered on the
computer keyboard. For example, to obtain a directory of drive
A: when running a Command Prompt window, you would enter

DIR A: RETURN

Bold Bold text is used for menu item commands, e.g. the Edit menu.
Where cascading menus are present, an arrowhead ( }) is used
to separate the sub -menus. For example, the Windows Control
Panel application is started from the desktop Start } Control
Panel command.

Important information that should be noted is written in italics, and separated from
other text by horizontal rules, as here.

Contacting Erithacus Software
Address

Erithacus Software Limited
PO Box 274

Horley

Surrey

RH6 9YJ

UK

14



Chapter 1: Introduction

Technical Support

At Erithacus Software we are working hard to provide you with intuitive technical
products. However, if you find yourself with a techni cal question that you cannot
resolve, please contact our technical support department. Registered users can
obtain technical support from one of the following sources:

1 Fax [+44] (0)1342 841 939
 Email: support@erithacus. com
T Internet :  http://www.erithacus.com/grafit

Note Always quote your serial number and the product version, which are shown
on the About screen (  Help } About GraFit  command).

Internet

Our web site can be found at http://www.erithacus.com and here you will find
latest information about our software products. In addition, we post technical
notes, tips and answers to common problems.

Tip Be sure to check out http://www.erithacus.com/grafit to download the
latest fixes and updates.

15


support@erithacus.com
http://www.erithacus.com/grafit
http://www.erithacus.com/
http://www.erithacus.com/grafit

GraFit User s Gui de

16



CHAPTER 2

Installation and Activation

System Requirements
Software
GraFit version 6 requires Windows 2000, Windows XP, Windows Vista or later.

Hardware
Any computer that  is capable of running the Windows operating system in use.

The GraFit Package

The GraFit package comprises the following:
9 GraFit program on CD -ROM or via electronic download.

T The GraFit Userod6s Guide (this manual). Depen:
was purchased, this guide may only be available in electronic form.

When GraFit is first run you will be able to register the product. Registration is
optional, but will ensure that you are informed of the latest updates to the
program.

Installing GraFit

Online Installation

Download and run the installation program from the GraFit website
(www.erithacus.com/grafit ).

CD-ROM Installation

Insert the GraFit CD -ROM into your CD or DVD drive. Th e Welcome screen will load
automatically.

Note Some systems are configured so that automatic running of CD -ROM
software is disabled. If your system is set up in this way, the Welcome
screen can be displayed by selecting the Run command from the Windows
Start menu, and entering the command D:\ CDRUNwhere D: is the drive
letter of your CD -ROM.

17
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GraFit
Select the Install GraFit option to install GraFit onto your computer. The
installation program will copy the files to your hard disk, and pla ce an entry for the

GraFit program onthe  Start button, underthe  Programs  entry.

Adobe Acrobat Reader

The GraFit installation includes this user manual saved in Adobe Portable Document
Format (PDF) . If you wish to r ead this file, it is necessary to have the Adobe
Acrobat Reader (version 5 or later) installed. If you do not already have this
software installed, you can choose to do so by selecting Install Acrobat Reader
Installation of Acrobat Reader requires your co mputer to be connected to Internet.

Activating the GraFit Program

After installing GraFit, whether from the CD -ROM or online, it is possible to run the
software in evaluation mode for 21 days. During this time the program is fully
functional. To continue running the program after the evaluation period expires, it

is necessary to activate the program online by entering a valid activation code
(serial number). Ac tivation codes are purchased; after the program has been
activated it will run without showing the activation dialog box again.

Activation Dialog Box

Before GraFit has been activated, running the program will produce the following
dialog box:

GraFit & Software Activation lilé]

This software is not yet activated.
Please enter your activation code (either full or evaluation) into
the box below and didk the Activate button.

Activate GraFit 6
Activation Code (full or evaluation):

|

Evaluate GraFit 6

‘You have 0 days of your evaluation period
remaining

l Change Proxy Settings... ] Purchase activation code online

This shows the remaining evaluation period; if you are still within the 21 day
evaluation period then you may run the program by clicking the Evaluate  button.

Once the evaluation period has expired you will not be able to run the software
until you have entered an activation code.

18
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Setting Proxy Settings

For some users, access to the internet needs to be via a Proxy Server. Providi
you can access the internet using a browser such as Microsoft Internet Explorer,
GraFit will automatically make use of any proxy settings that might be needed. In
some rare circumstances it may be necessary to use custom proxy settings in order
to acces s the internet; these can be set by the

Running in Evaluation Mode

The software can be evaluated for

evaluation period, click the

Change Proxy Settings button.

21 days prior to purchase. To start your

Eva luate button. In order to start the evaluation your
computer must be able to access the internet.

The first time you evaluate the software, you will need to supply information about

where the Evaluation code should be delivered. This code will be emailed t

the address entered into the following dialog box:

(Get Evaluation Activation Code

i

Evaluation email address

Email:

Confirm email:

Please enter and confirm the email address that your
evaluation activation code will be sent to

| Cancel

4

Click OK to request an evaluation activation code. This code will be sent
immediately, but you should allow a few minutes for your email system to process

the message.

ng

o you at

Note Most email systems ar

e set up to move unsolicited email to a "Junk" email

folder. In the event that you cannot find your evaluation code email, try

looking in your Junk folder in case it has been moved there.

Using the Evaluation Activation Code

When you receive the email with

box and click the  Activate

button.

your code, paste this into the

Activation Code

During activation you will be asked to provide a password, which will be needed in
future if you reactivate or deactivate the software and an email address that is

used to a llow automatic reminders to be sent if you forget your password.

During the evaluation period the software is fully functional. After the evaluation
period has ended it will no longer be possible to run the software unless you
purchase and enter an evalua  tion code.
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GraFit running in evaluation mode
Purchasing a Full Activation Code

Full Activation codes can be purchased online by following the link on the Activation
dialog box.

Activating the Software

Once you have purchased a full activation code, paste this into the Activation
Code box and click the  Activate  button. If you purchased GraFit on CD  -ROM the
activation code (serial number) will be present on the software case; if you have
downloaded the so ftware you may purchase an activation code online.

During activation you will be asked to provide a password, which will be needed in
future if you reactivate or deactivate the software. You will also be asked to provide

an email address. This address is u sed to allow automatic reminders to be sent if
you forget your password.

Activation is done via the internet; if your computer is not connected to the
internet it is possible to carry out offline activation. See the online help for a full
description of ho w offline activation is carried out.

Deactivating GraFit

Your GraFit software needs to be activated on -line, during which time a count is
made of the number of times an individual activation code is used. You will not be

allow ed to activate software more than the number of times allowed by your
license agreement. This means that if you wish to move your software to a
different computer you should first deactivate it on the original computer.

Warning  Once you have deactivated yo ur software it will no longer run until it is
once more reactivated.

Deactivation

To deactivate your previously -activated software, select the Help About  dialog and
select the Deactivate  button. You will need to enter the password that you gave
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when you or iginally activated the product. If you have forgotten your password,
clicking the Forgotten password? button will automatically email this to you

Changing Computers

If you change computer, it is necessary to deactivate your GraFi t installation from
the old computer before reinstalling the program on the new computer.

Checking for Software Updates

You can check to see whether any program updates are available by running the
Help } Check for Updates command. If updates are available online you have the
opportunity of downloading and installing them.

Uninstalling GraFit

GraFit can be removed from your system by the following procedure.

1. Fromthe W indows Start menu, launch the Control Panel application.

2. Double -click the Add or Remove Programs icon.

3. Choose GraFit 6 to uninstall, and click the Change/Remove button.
4. Follow the instructions

Note We recommend that you deactivate GraFit , as described abov e, prior to
uninstalling the program.
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CHAPTER 3

GraFit Basics

Running GraFit

The GraFit installation program will add a GraFit entry to the Programs list on your
Windows Start menu. When you run the GraFit program, the main GraFit window
will open.

Ribbon or Menu and Toolbars

GraFit 6 uses by default an Office 2007 -style ribbon bar to access the various
commands. The ribbon bar combi nes the functionality of both toolbars and menu
bars, which are used in more traditional Windows programs.

Office 2007 -style Ribbon Bar

GraFit logo button. Click here to access the File menu

ﬁ Quick Access Toolbar

GraFit 6 using the Office 2007 -styl e ribbon bar

The ribbon bar displays commands grouped on a series of tabs, giving a less
cluttered |l ayout than the traditional di spbay,
that can be customized to hold commonly used command s in a consistent manner.

The File menu is accessed via the GraFit logo button, found in the top left of the

GraFit window.

Using the Ribbon Bar

The ribbon bar comprises a set of tabs that hold related commands. Each tab has
one or more ribbon groups that collect toolbar buttons. Click on the button to
activate the command.
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